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Welcome to RUSLE2 
 
Version 2 of the Revised Universal Soil Loss Equation (RUSLE2) estimates soil loss from rill and interrill 
(sheet and rill) erosion caused by rainfall and its associated overland flow.  RUSLE2 uses six factors for 
climatic erosivity, soil erodibility, slope length, slope steepness, cover-management, and support 
practices to compute soil loss. 
    
RUSLE2 is a powerful tool for conservation planning, inventorying erosion rates over large areas, and 
estimating sediment production that might become sediment yield in watersheds.  It can be used on 
cropland, pastureland, rangeland, disturbed forestland, construction sites, mined land, reclaimed land, 
landfills, military lands, and other areas where surface overland flow occurs because rainfall is greater 
than infiltration. 

 
About RUSLE2 

 
The structure of the revised universal soil loss equation RUSLE2 is based on the Universal Soil Loss 
Equation (USLE), which is given by:  
 

A = R K L S C P 
 
where A = average annual soil loss from rill and interrill erosion caused by rainfall and its associated 
overland flow (tons ac-1 yr-1), R = the factor for climatic erosivity, K = the factor for soil erodibility 
measured under a standard condition, L = the factor for slope length, S = the factor for slope steepness, 
C = the factor for cover-management, and P = the factor for support practices.  A value for soil loss A is 
computed by selecting values for each factor and multiplying them. 
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RUSLE2 PROGRAM SETUP 
 
Create a RUSLE2 Shortcut Icon for Your Desktop 
To create a RUSLE2 Shortcut Icon for your desktop, simply  navigate to Start \ All Programs \ USDA 
Applications \ RUSLE2 \ RUSLE2 Erosion Protection.  DO NOT LEFT CLICK, instead right click your mouse 
and go to “Send to”, click desktop (Create Shortcut).  This will place a shortcut on your desktop. 

 
Open the RUSLE2 Program 
 
You can open the RUSLE2 program by clicking on the RUSLE2 icon on the Desktop.                   
Or by clicking on Start > Programs > USDA Applications > RUSLE2 
 
Choosing the correct template 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1) This screen should appear when RUSLE2 
is first opened. Choose the NRCS simple 
07102014 template.  You may also 
choose the NRCS summary 07292014 
template to evaluate filter strips.  Once 
you choose this template then simply 
click OK.  This will set your RUSLE2 
program to the correct template. 

 

2)    This screen may or may not appear.  If it 
does appear, click Cancel. 
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If neither of the above screens appear, follow the steps below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:  You do not need to set the template again each time you open RUSLE2 unless you wish to change 
it.  Your RULSE2 program will automatically default to the template you choose each time you open the 
program. 

 
 

Set your RUSLE2 Program to the Correct Database (FOR NRCS USERS ONLY) 
 
When RUSLE2 is installed on your computer, the program automatically creates and defaults to an 
empty database located in your C:Drive.  This database is called “moses”.  It is the database which stores 
all of your RUSLE2 data including crop rotations, managements and RUSLE2 calculations or farm data.  
For Conservation Planning and using RULSE2 you will need to re-direct the database to another database 
which is located on your Shared Drive.  This will ensure you are working with the most up-to-date 
information when using RUSLE2 and that your work is saved to the Server each night.    
 
NOTE:  It is EXTREMELY IMPORTANT that you use RUSLE2 with the correct database.  Failure to use 
the correct database could result in loss of RUSLE2 field data. 
 
When RUSLE2 was installed on your computer, the program creates and automatically defaults to a 
“moses” database located on your C: drive.   You will need to re-direct this database to your S: shared 
“county_moses” database.  To do this simply complete the following steps: 
 
 

1) From the toolbar menu, click on Options / 
Template / Load.  

2) Choose NRCS simple 07102014.xml or you 
may choose NRCS summary 07292014.xml. 
Click open.  This will set your computer to 
the proper template.  
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NOTE:  Once you complete the above steps, there is no need to continue with the following steps for 
downloading and importing database sets. All Climate, Soils, and CMZ (Crop Management Zone) data 
sets are available on the County’s shared drive. You many go directly to RUSLE2 Introduction on pages 
13 through 28. 
 
If you do not have an S: drive, shared “moses” database, you will need to complete the following 
steps to download and import the database sets.   

1) At the top of the RUSLE2 screen 
click on Database, then choose 
Open Alternate. The following 
screen will appear.   

2) Click the drop down menu, navigate 
to your S:Drive and locate your 
shared “moses” database.  Your 
shared “moses” database is located 
at S:\NRCS\RUSLE2.  In there should 
be your specific county “moses” 
database.  It should be named 
county_moses.   
**Example:  Kent_moses.  Click once 
on your county specific “moses” 
database and then click “Open”.  This 
will re-direct your database to the 
shared drive.  All existing files and 
information from your county field 
office that has been completed using 
RUSLE2 will now be available for your 
use and information. 
 

3) Set the shared “moses” database to 
always open to this database.  To do 
this, simply go to menu toolbar and 
click on Database.  Next, choose 
Startup Database.  Click once on this 
and it will place a check to the left of 
Startup Database.  This will ensure 
each time you boot up RUSLE2, you 
go to the correct shared 
“county_moses” database. 
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Downloading RUSLE2 Databases 
 
RUSEL2 Folder/Data Location 

The RUSLE2 program itself is kept at Computer > LocalDisk (C:) > Program Files (x86) > USDA > Rusle2 > 
NRCS, however, the data for the program is kept at Computer > LocalDisk (C:) > ProgramData > USDA > 
RUSLE2 > NRCS. The ProgramData folder is a hidden folder and may not be seen on all computers until 
the view is setup correctly. 

To unhide hidden folders: 

1) Open the windows explorer and click on the “Organize” button at the top of the screen 

2) Select “Folder and Search Options” from the menu. 

3) The folder options screen will appear. Click on the middle tab that says “View” 

4) The radio button that says “Show hidden files, folders, and drives” needs to be selected 

5) Click “OK” and you will then be able to see the ProgramData file the next time windows explorer is 
opened 
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Download Base Database and Database Updates - NRCS USERS CAN SKIP THIS SECTION 
 

1) From the RUSLE2 website, navigate to Base Database & Misc Files > Download Files > Latest Base 
Database and Updates 
http://fargo.nserl.purdue.edu/RUSLE2_ftp/NRCS_Base_Database/Latest%20Base%20Database%20and%20
Updates/ 
 

2) Click on “NRCS Moses Updates 030104 to 01292015.zip”  

3) A pop-up will appear at the bottom of the screen. Click on the arrow next to the “Save” button and 
“Save As” Computer > LocalDisk (C:) > ProgramData > USDA > RUSLE2 > NRCS > Import 

 
Download Crop Management Zone (CMZ) Database - NRCS USERS CAN SKIP THIS 
SECTION 
 

1) Determine which CMZ database you will need to import. The CMZ maps can be found here: 
30TUhttp://fargo.nserl.purdue.edu/rusle2_dataweb/NRCS_Crop_Management_Zone_Maps.htmU30T 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) From the RUSLE2 website, navigate to Crop Management Templates > Data Files 
http://fargo.nserl.purdue.edu/RUSLE2_ftp/Crop_Management_Templates/ 

 
3) Click on the data files for the needed CMZ (CMZ 59, CMZ 66, CMZ65, or CMZ 04.1) 

4) A pop-up will appear at the bottom of the screen. Click on the arrow next to the “Save” button and 
“Save As” Computer > LocalDisk (C:) > ProgramData > USDA > RUSLE2 > NRCS > Import 

 
5) Save all needed to the same location 

http://fargo.nserl.purdue.edu/RUSLE2_ftp/NRCS_Base_Database/Latest%20Base%20Database%20and%20Updates/
http://fargo.nserl.purdue.edu/RUSLE2_ftp/NRCS_Base_Database/Latest%20Base%20Database%20and%20Updates/
http://fargo.nserl.purdue.edu/rusle2_dataweb/NRCS_Crop_Management_Zone_Maps.htm
http://fargo.nserl.purdue.edu/RUSLE2_ftp/Crop_Management_Templates/
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Download Soils Data - NRCS USERS CAN SKIP THIS SECTION 
 

1) From the RUSLE2 website, navigate to Soils Data > Data Files 
Uhttp://fargo.nserl.purdue.edu/rusle2_dataweb/NRCS_Soils_Data_Files.htmU30T 

 

2) Navigate to the Maryland folder 
 

To Download Soils for Individual Counties: 
 
1) Right click on the county (ex. “Carroll County, Maryland.gdb”) and click “Save Target As” 

Computer > LocalDisk (C:) > ProgramData > USDA > RUSLE2 > NRCS > Import 
 
 
Download Climate Data - NRCS USERS CAN SKIP THIS SECTION 

1) From the RUSLE2 website, navigate to Climate Data > Data Files 
30TUhttp://fargo.nserl.purdue.edu/RUSLE2_ftp/Climate_data/U30T 

 

2) Click on “MD_clime042403.zip” 

3) A pop-up will appear at the bottom of the screen. Click on the arrow next to the “Save” button and 
“Save As”  Computer > LocalDisk (C:) > ProgramData > USDA > RUSLE2 > NRCS > Import 

 

 
Importing Files 

NRCS USERS CAN SKIP THIS SECTION 
 

Extracting Files 

1) Once all of the data files have been downloaded, Open windows explorer and navigate to the same 
location: 
Computer > LocalDisk (C:) > ProgramData > USDA > RUSLE2 > NRCS > Import 

 
2) Right click on the downloaded CMZ file 

 
3) Hoover over “WinZip” and click on “Extract to here” when the submenu appears 

 
4) Repeat this steps 2 and 3 for every zip imported zip file (Note: If county soil files are in .gdb format, 

they are already unzipped) 

5) Once all of the files have been unzipped and saved to the import folder, open the RUSLE2 program 

 

 

 

http://fargo.nserl.purdue.edu/rusle2_dataweb/NRCS_Soils_Data_Files.htm
http://fargo.nserl.purdue.edu/RUSLE2_ftp/Climate_data/
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Base Database Update 
1) Click on “Database” and “Import Database…” 
 
 
 
 
 
 
 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

2) A new screen titled Select import 
database will appear with all of the 
available databases to import. 
Choose 
NRCS_Moses_updates_030101_to_
01292015.gdb.  Click open. 

3) Click on the top left folder. This will 
automatically check all of the folders. 
When importing a new master database 
or a master database update, it is 
important to click on the top left folder 
that will populate each folder with the 
appropriate files. 

4) Under the “Include dependent files” box, 
“All” checked at the default. You want this 
to be checked as “None” 
 

7) Click on “Import to same folder” and click 
the “Import” button 
 



Maryland RUSLE2 User's Guide – April 2017  Page | 11   

 

 

  
 

7) The database import will then run 
through a series of windows while 
the program downloads the files. 
Click “OK” when the import 
complete box pops up and click 
“OK” when a window appears saying 
the import has finished.  

 

 

 

Crop Management Zones (CMZ), Soils, and Climate 
 

1) Click on “Database” and “Import Database…” 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6)   A warning message will appear. Click “OK” 
 

2) A new screen titled Select import 
database will appear with all of the 
available databases to import. Click 
the crop management zone (CMZ) 
you want to download.  Click open. 
 
** Soils - Choose the county and 
click open. 
 
** Climate – Choose “MD 
clime042403.gdb” and click open. 
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7) The database import will then run 
through a series of windows while 
the program downloads the files. 
Click “OK” when the import 
complete box pops up and click 
“OK” when a window appears saying 
the import has finished. 

6)   A warning message will appear. Click “OK” 
 

3) Click on the managements folder (make 
sure the CMZ you want to download is 
checked).   
** When importing soils data, click on the 
“soils” folder (make sure the county you 
want to download is checked). 
 
 **when importing climate data, click on 
the “climates” folder. 

4) Under the “Include dependent files” box, 
“All” checked at the default. You want this 
to be checked as “None” 
 

5) Click on “Import to same folder” and click 
the “Import” button 
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RUSLE2 INTRODUCTION 
 
Program Feature Icons 

 
Plan Description View – (Green Watershed Icon) This is the template to use to calculate soil loss for 
multiple fields.  These calculations can be made for single systems or multiple alternatives. Use this view 
for whole farm conservation planning. 
 
Field Worksheet View – (Data Sheet) This is the template to use to calculate soil loss alternatives for one 
field or one slope. 
 
Profile View – (Green Sloping Line) This is the template for calculating soil loss for one slope or one field.  
Can only be used for single systems. 

 

 
 
These icons below contain specific information for use when developing RUSLE2 crop rotations for soil 
loss calculations.  Before use of these below, be sure to have had basic RUSLE2 training.  Failure to do 
this may result in loss of data. 
  
 
 
 
 
 
 
 
 
 
 
 

Plan Description 
View – Multiple 

Fields 

Worksheet View – 
Single Field Alternatives 

Profile View – Single Field 
Calculations 

Climate 
Storm 

Erosivity Soil Management Operation 

Vegetation 
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Climate 
The climate object describes the weather information for the site.  The information in this object 
includes data on annual erosivity, 10 yr EI storm, average monthly temperature, and average 
monthly precipitation.  Information is cataloged in the database according to names of locations. 
 
Storm Erosivity 
Storm erosivity varies through the year depending on location.  The information in the storm 
erosivity object describes how erosivity varies during the year as a function of zones or regions.  
Information is cataloged in the database according to a zone number. 
 
Soil 
The soil object includes information on soil erodibility, soil texture, hydrologic soil group, and 
rock cover.  Also, this object includes the soil erodibility to compute a value for the soil 
erodibility factor if one is not available.  Information is cataloged in the database according to a 
soil name, which could be a soil-mapping unit from an NRCS soil survey. 
 
Management  
The management object contains information on management practices.  Each practice typically 
includes a list of dates and the operations, vegetation, and applied materials like mulch and 
manure associated with each date.  Information is cataloged in the database according to a 
management name chosen by the user. 
 
Operation 
The operation object contains the information used to describe operations.  A key component of 
the information used to describe an operation is processes including begin growth, kill 
vegetation, flatten standing residue, disturb surface, remove surface cover, and remove live 
biomass.  Information is cataloged in the database according to an operation name chosen by 
the user. 
 
Vegetation 
The vegetation object contains the information used to describe live vegetation.  This 
information includes a name for the residue to associate with the vegetation and data on yield, 
the relationship of above ground biomass to yield, how the vegetation slow runoff, and 
temporally varying values on root biomass, canopy cover, fall height, and live ground cover.  
Information is cataloged in the database according to a vegetation name chosen by the user. 
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Creating a RUSLE2 Rotation 

1) Before opening the managements button, make sure the screen template is set at NRCS simple 
07102014 or 
NRCS summary 07292014 

 

 
 

 
 

 
 

3)   To create a new rotation, click on the default file when the Open screen pops up 
 

 
 

5) A new screen will appear that will allow you to build a base rotation using templates that can 
be edited to meet the exact rotation that is being used on the operation. The rotation to be 
used in this example is 2 years corn, tandem disc with coiled tine harrow, 1 year no-tilled 
wheat with no-tilled rye cover crop, 1 year soybeans, tandem disc with coiled tine harrow. 

 
6) To create this rotation, add the first crop in the rotation by clicking on the down arrow under the 

“Management” column. 
 

2)   Click on the “Open management…” button 

4)   When the default screen opens, click 
on “Open” folder button to the right 
of “View/edit rotation builder used to 
make this management” 
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Click on the square to the left of the 
row that needs to duplicated or deleted 
and press the + or – buttons 

An operations list of the current 
management will be seen to the right of the 
rotation builder, as more crops are added, 
the Operations List will adjust so you can 
view the management template before 
editing 

 
 
 
 
 
 
 
 
 
 
 
 

9) Continue to add crops to the rotation by 
choosing the crops and management from the 
dropdown box 

10) Once all of the crops in the rotation have been 
added, click the “Apply/Close” button at the 

7) From the drop down menu, select the CMZ that you the rotation will be used in (CMZ59 in this example) > a. 
Single Year/Single Crop Templates > Corn Grain > corn grain;sdos 

 
8) Crops can be added or deleted by highlighting the row and hitting the + or – buttons. If a row is highlighted 

and the + button is hit, another year of that same crop and management will be added below the 
highlighted row. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
bottom of the rotation builder screen 
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11) The rotation builder will close and a management screen will appear with the chosen crops and 
managements. From this screen, add or delete rows to make the rotation as close as possible to the actual 
management on the operation. 

 

 
 

 

Changes to make: Producer only discs twice 
(RUSLE2 automatically populated three 
times), cultivator is not used, harrow is not 
included. 
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12) NEW Management View! 
 
 

The average STIR value is displayed as well as the Crop 
Year STIR values. Only the average will be displayed in the 
worksheet view, but refer to the Crop Year STIR values to 
make sure you are meeting the standard if planning 
329/345. 

Double check the crop intervals so they are marked 
correctly. “YES” should be marked next to the operations 
where a harvest occurs. Many single year management 
templates will include weed growth. The program will 
most often recognize weed growth and cover crops and 
their own crop, which will need to be corrected. A crop 
interval is defined as the interval between the harvest of 
the previous crop to the harvest of the current crop. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

13) Save your crop management template. Go to File > Save As > CMZx  > 
c. Other Local Mgt Records. You will know if the changes in the template you 
are working on have been saved or not by the presence of a * at the end of 
the file name in the heading of the management view. Once the changes 
have been saved the * will disappear. 
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Creating a Plan in RUSLE2 – applying the crop rotation and calculating 
soil loss 

1) Before opening the plan view, make sure the screen template is set at NRCS simple 
07102014 or NRCS summary 07292014 

 

 
 
 

 
 

 
 
 

3) Any existing plans will appear in the screen. If you want to edit an existing plan, you can do 
so from here. If you would like to begin with a new plan, click on default (or county specific 
default, if one was created) 

 

 
 
 

2
) 

Click on the Plan View 
button 

4) Enter the basic information needed to identify the plan. In the “Info” box, can type the 
description of the fields or treatment being evaluated.   

5) Click and open the folder to the right of the worksheet you want to work on 
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Enter the field name (number) 

NEW: Color coded “SCI value OK?” 
Red = SCI is below -0.2 
Yellow = SCI is between -0.2 and 0.2 
Green = SCI is above 0.2 

Choose 
soil type T value 

Enter slope length and 
slope steepness 

Choose management, navigate 
to the CMZ, c. Other Local Mgt. 
Records 

6) Enter information within the worksheet 
a. Enter the field name/number 
b. Choose the soil type 
c. Enter the slope length and steepness 
d. Choose management. If choosing a crop management template that was created, navigate to the correct CMZ file > c. Other Local 

Mgt Records > and choose the existing or planned management.  Can also choose an existing management located in a. Single 
Year/Single Crop Templates or b. Multi-year Rotation Templates 

e. Choose contouring - The row grade is the percent of grade off the contour. (e.g. Absolute row grade-1% means the contouring is 
actually on a 1% grade across the slope) 

f. Yields – To adjust crop yields, click the yellow folder next to “Yields”.  Another box will open, type in the desired yield for each 
crop and then click the red X to close the box.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Actual soil loss 
over the rotation 

 

 NEW: Color coded “Soil loss OK?” 
Red = over 2T 
Yellow = between T and 2T 
Green = T or below T 
 

 
 
 
 

7) Compare the T value with the Cons. plan soil loss t/ac/yr. The bar next to this number will toggle from green to yellow to red, with red 
indicating the management did not meet the tolerable soil loss.  

 

Choose contouring 

Adjust Yields 

Enter the field name (number) 
 

Choose 
soil type 
 

T Value 

Choose management, navigate 
to the CMZ, c. Other Local Mgt. 
Records 
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8) Look at the SCI value. If this value is under 0.0, the producer is depleting the soil organic matter faster than it can be rebuilt. The bar 
next to the SCI will toggle from green to yellow to red depending on the value.  
 

9) To add a new scenario to this field’s worksheet, press the + button to add a new row. Any information from the top row will be 
automatically copied to the row below when the + button is used. 
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Incorporating Manure into Crop Management File 
 
RUSLE2 describes the effect of manure additions to soil by considering how much biomass is 
incorporated and how much is left on the surface.  The solids of the material left on the surface are 
treated as ground cover subject to decay.  The organic material incorporated is treated like 
incorporation of crop residue and is subject to decay.  Knifing manure into the soil is treating as a soil 
disturbance that is described in the same way that a tillage operation is described.   
 
Manure is treated as a residue in RUSLE2, and values for the properties for manure are entered in the 
residue database.  Add manure to a crop rotation in the management screen of RUSLE2 (see illustration 
below).  Enter the manure operation in the operations section, then choose the type of manure under 
“Type of Cover Material”.  Next, open the Type of Cover Material choice (click yellow folder next to 
residue type) and choose the correct amount of residue applied.  Amounts are listed by coverage vs. 
mass. 
 
 

 
 
 
 
 

 

 

  
 
 
 
 

 
 
When manure application is included in the operation of the Crop Management File you will need to 
include the manure operation.  When you select the manure operation in RUSLE2 a dialog box will 
appear to the right of the operation that requires you to include the type of manure that you are 
applying.   

 
RUSLE2 requires that inputs for the amount of manure added to a field be input as mass/ac dry weight. 
A method to convert the fresh or wet weights of manure to dry weight is shown below.    

Laboratory data should be used in lieu of these conversion methods where available.  Moisture 
content estimates are also available in the Agricultural Waste Management Handbook for various 
manure classes.    

Where to enter type 
of manure and 
amount applied. 



 

Maryland RUSLE2 User's Guide – April 2017   Page | 23 

Equations to Convert to Pounds Dry Matter  

(A) For liquids and slurries  
(gals /ac) X (8.34 lbs/gal) X (% solids as a decimal) = lbs dry matter   

Sample calculations:  
(10,000 gal /ac) X (8.34 lbs/gal) X (0.02) = 1668 lbs/ac dry matter   
RUSLE2 Conversion: 1668 lbs/ac dry matter X 0.5 = 834 lbs/ac

(B) For semi-solids  
(lbs /ac) X (% semi-solids as a decimal) = lbs dry matter   

Sample calculations: 
(8000 lbs /ac) X (0.15) = 1200 lbs/ac dry matter    
RUSLE2 Conversion: 1200 lbs/ac dry matter X 0.5 = 600 lbs/ac 
 

(C) For solids  
      (lbs /ac) X (% solids or semi-solids as a decimal) = lbs dry matter   
 

Sample calculation:  
(8000 lbs /ac) X (0.55) = 4400 lbs/ac dry matter  

 
 
Recommendations for Types of Manure in RUSLE2 Database:  

• Manure, liquid - (swine from confinement, holding ponds and municipal sewage): Use Equation A 
• Manure, semi-solids - (includes beef, swine and dairy settling basin): Use Equation A  
• Manure, open lots - (beef, swine, dairy manure from open lots and buildings and poultry manure): Use 

Equation B 
• Manure, solids or with bedding - (horse, sheep packs including straw and shredded newspaper): 

Use Equation C 
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Irrigation  
 
RUSLE2 cannot be used to compute soil loss from surface irrigation, but it can be applied to surface 
irrigated land to compute soil loss from natural rainfall.  Since irrigation leaves the soils wetter and thus 
produces more runoff from natural rainfall than without irrigation, the permeability code in the soil 
erodibility nomograph can be adjusted one step to a less permeable soil.  However, in climates where 
little rainfall occurs during the irrigation season, this adjustment is unnecessary. 
 
The other consideration given to surface irrigated land is that these lands are frequently graded to 
produce long gentle slopes.  Slope lengths for these fields can be much longer than slope lengths on 
similar fields that have not been graded. 
There are three ways to enter irrigation.  Rate, Depth and Monthly.  All values are entered in the 
Management Screen.  See below for each. 
 
Enter irrigation application by rate 
To enter the irrigation application by rate, you will need to choose the amount of irrigation in inches on 
a per day basis. 
 
Enter irrigation application by Depth 
By entering the irrigation application by Depth, you can bracket the irrigation period.  See example 
below. 
 
Enter irrigation application by Month 
This method allows the user to enter the total amount of irrigation for the crop in inches on a month to 
month basis.  See below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1) Click the drop down menu and 
choose the correct method of 
application (Application rate, 
application depth, or monthly 
application depth) 

2) Click the yellow folder.  
Application Rate: enter date of 
application and amount of water 
applied (inches).  Note: click the 
+ sign for additional dates 
Application Depth: enter 
irrigation amount (inches) by 
period. 
Monthly Application Depth: 
enter irrigation amount (inches) 
by month for each crop.  
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Strips/Barriers  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the correct strip cropping choice:  
Unless your slope length is longer than 200 feet, you probably only have (2) strips on the “Length” (L). 
 
In the choices 2 Strip rotational 0-1 means:  2 strips on the “L” and the 0-1 means the 1st and 2nd crop in 
the rotation are next to each other (this would be a two year rotation). 
In a 0-2 means the 1st and 3rd crops in the rotation are strips next to each other (this would be a four 
year rotation like such as corn-wheat-hay-hay where corn 1st year and hay are adjacent or wheat and 2nd 
year hay are adjacent to each other. 
 
 
Selecting Filter Strips 
 (This applies if a filter strip is located at the bottom of the “L”):  

• Two Main Choices Are Available – Actual Width or Percent of the “Length”.  
• Select the width and the type of cover.  If you do not find the exact match select a similar choice – 

most produce very similar results.  
 
 
Selecting Contour Buffer Strips 
 1st Select the actual width of the buffer 
 2nd Select the number of strips in “L” 
 3rd Select the type of cover 

 
 

Strips/Barriers 
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Adjust Rock Cover - Guidelines for Estimating Rock Cover in the Field   
  
Introduction:  The RUSLE2 computer program has an input box on the Profile view screen for “Rock 
cover, %”.  This document offers guidelines for making estimates in the field for the percent cover from 
rock, rock fragments, or coarse fragments.  Coarse fragments on the soil surface effect the Cover and 
Management factor in RUSLE2.  Rock cover does not effect the Soil Erodibility factor.    
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Caution - Use Good Judgment: Research data shows that the presence of rock cover can significantly 
reduce soil erosion, and the RUSLE2 model accounts for this effect.  However, users should be cautioned 
to exercise good judgment when developing conservation planning alternatives that reflect the 
presence of surface rock fragments.  For example, a rock cover entry in RUSLE2 that reduces soil loss to 
acceptable levels should be re-considered if the hillslope shows clear evidence of severe, active erosion.  
 
RUSLE2 uses the Kf (rock free) soil erodibility factor. 
If surface rock fragments are present and not entered, erosion is over predicted. 
 
RUSLE rock fragments are defined as those greater than 3/8 of an inch in size. 
 
 
 
 
 
 

Click on the yellow 
folder and the window 
to the left will open.  The 
percent rock cover can 
be entered here. 



 

Maryland RUSLE2 User's Guide – April 2017   Page | 27   

The following are guidelines to use in RUSLE2, if the surface rock fragment cover is not measured in the 
field.  
 

Surface Texture Modifier Rock Fragment Content Range Amount to use if no field 
measurement  

No Texture Modifier 0-15 3 
channery, shaly, gravelly, 
cobbly, cherty, flaggy 

15-35 15 

very channery, very shaly, very 
gravelly, very cobbly, very 
cherty, very flaggy 

35-60 35 

 

 
 

Estimating Soil Erosion with Ridges and Beds 
 
 
Ridges and Beds, Defined for Purpose of RUSLE2 Applications 
For the purpose of RUSLE2 application, ridges are a series of reoccurring ridges and furrows left by 
tillage implements such as chisel plows, hippers and disk hillers.  The top of these ridges are not flat for 
any appreciable length.  Beds, for the purpose of RUSLE2 application, differ from ridges in that the raised 
areas (top of the beds) are commonly several feet across the top, and must be at least one foot wide 
across. 
 
Representing Beds Using RUSLE2 
RUSLE2 does not calculate soil loss in the furrows of these beds.  Therefore, the topographic inputs 
must represent the flow path across the bed, then down the side of the bed to the furrow. 
 
This implies that either 1) RUSLE2 provides reasonably good erosion and sediment yield results when 
minimal erosion occurs in furrows because of high residue cover in the furrows or low furrow grades; or 
2) the furrow carries excessive runoff and experiences excessive erosion, a process more closely 
resembling concentrated flow erosion, a process that RUSLE2 does not currently model. 
 
When Beds are Generally Up-Down the Hillslope:  
Represent the cross-section from the middle of one bed to the middle of the next bed.  The RUSLE2 
output represents runoff and erosion from the middle of the bed to the furrow.  Typically, water does 
not run along the top of the bed for any appreciable length, and instead will run off the side and into the 
furrow.  In the table below, the top of one bed is represented with a 1% grade and 2-ft length, and the 
sideslope of that bed is represented with a 50% grade and 1-ft length.  The adjacent bed across the 
furrow is represented with similar, but negative values. 
 

SEGMENT STEEPNESS (%) LENGTH (ft) 
1 1 2 
2 50 1 
3 -50 1 
4 -1 2 
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When Beds are On or Near the Contour:   
Represent the flow path across a bed and down the bed’s sideslope to the furrow.  An example is 
illustrated in the table below in which runoff across the top of the bed is represented with a 2% grade 
and a 4-ft length; and runoff down the bed’s sideslope to the furrow is represented with a 50% grade 
and 1-ft length. 
 

SEGMENT STEEPNESS (%) LENGTH (ft) 
1 2 4 
2 50 1 

 
 
Representing Ridges Using RUSLE2 
Represent the topography up-and-down the hillslope in the path the runoff would follow if the soil 
surface were flat (as if ridges were not present).  If the ridges are on contour/near contour, select the 
row grade from the drop-down menu for Contouring.  
 
NOTE:  The science in RUSLE2, in most instances, is adequate to represent ridge-furrow systems because 
it is based on research data on ridge-furrow systems with a “normal spacing.” But RUSLE2 does not 
adequately represent “abnormally” wide beds, and the subsequent wider spacing of furrows because 
runoff comes from a larger area on the bed and flow concentrates in the furrow. 
 
A Ridge factor built into RUSLE2 “enhances” erosion when ridges are up-down but “diminishes” it with 
contouring.   
 
Sediment Delivery in Furrows 
RUSLE2 will model sediment deposition in the furrow resulting from low channel grade, but not 
deposition resulting from increased roughness such as from high residue in the furrow.  Currently we 
have no way of modeling the channel shape and roughness, and the effects of different residue levels in 
the furrow compared to the ridge or bed.   
 
In eroding landscapes, furrow grades are often too steep for deposited sediment to remain in the 
furrows.  Therefore the sediment delivery value is the same as the soil loss value.  However, if the 
furrow grade is sufficiently flat (often associated with low runoff and/or residue in the furrow), sediment 
delivery to the end of the furrow will be less than the soil loss value. 
 
Plastic Mulch on Beds and Ridges 
Select the Plastic Mulch Application Operation that best represents the percent cover provided by the 
plastic mulch to the field.  So, the estimate of percent cover must include the furrow areas as well as 
the beds or ridges. 
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Results of RUSLE2 Calculations 
 
There are several items of information that RUSLE2 provides.  Some of these items are very important 
and needed for certain conservation programs such as the Conservation Security Program.  Soil loss, Soil 
Conditioning Index (SCI) and the Soil Tillage Intensity Rating (STIR) are just a few of RUSLE2 ratings.   
 
Soil Loss for Conservation Planning, recorded in tons/acre/year 
 
The soil loss for conservation planning is the average soil loss over the length of the slope, where partial 
credit is given if deposition occurs on the slope.  It is the value for slope detachment (mass of sediment 
produced on the slope) reduced by the credit given for the deposition that occurs on the slope.  Units 
(e.g. tons/acre per year) are expressed in terms of mass of sediment, divided by the area determined by 
the slope length used in the RUSLE2 computation.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Soil Conditioning Index (SCI) and Average Annual Soil Tillage Intensity Rating 
(STIR) 
Click the Additional Results tab, click the yellow folder next to Soil Conditioning Index. 
The SCI is the Soil Conditioning Index rating.  If the calculated index is a negative value, soil 
organic matter levels are predicted to decline under that production system. If the index is a 
positive value, soil organic matter levels are predicted to increase under that system.  
 
The STIR value is the Soil Tillage Intensity Rating. It utilizes the speed, depth, surface disturbance 
percent and tillage type parameters to calculate a tillage intensity rating for the system used in 
growing a crop or a rotation.  STIR ratings tend to show the differences in the degree of soil. 
 
(See next page for example) 

 
 

Soil Loss T/AC/YR 
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STIR 
Value 

SCI Value 
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Printing Reports 
 
After you have completed data entry and the results are displayed in either the WORKSHEET, PLAN, or 
PROFILE view, you can print the results for viewing and saving as a permanent record.  The record can 
be saved anywhere in your file directory.   
 
Note:  The instructions below can be used for either the WORKSHEET, PLAN, or PROFILE view. 
 

1) Click on File on the menu toolbar.  Select Print Report. 

 
 

2) After the dialogue box appears, choose a print template that will display the SCI and STIR value.  
For example in Plan View, choose MD NRCS RUSLE@ Plan Record short 06062013.pln.dot or MD 
RUSLE2 Plan Record Detail.pln.dot.  After selecting the appropriate template, click “Open”.  MS 
Word will open and display your record of results. At this point, you have the option of printing 
and/or saving the document in your file directory.  If you want to save this RUSLE2 run, click the 
File menu, and do a Save As.  Give it a name and Save.  
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Help Screens 
 
Version 2 of RUSLE has been outfitted with various help screens to aid the user when developing soil 
loss calculations.  To access the help screens, follow the example below.   
 
In this example we chose Base Management. Place cursor over the section you would like help on and 
right click.  Choose “Help”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The following help screen will appear. 
 
 
 
 
 
 
  



 

Maryland RUSLE2 User's Guide – April 2017   Page | 33   

Abbreviations – Arranged Alphabetically 
 

bd broadcast method of seeding, usually cover crop 

dc double cropping such as corn or soybeans following small grain, or corn following 
hay harvest; mostly in south-central and south-eastern PA 

dcnr same as above but planted with a drill 

fc1 field cultivator equipped with sweeps – one pass 
fc2 field cultivator equipped with sweeps – two 
passes 

fcst chisel with straight shanks – moderately aggressive chisel  

fcswp chisel with sweeps – less aggressive chisel 

fctw chisel with twisted shanks – most aggressive 
chisel fdos offset disk – most aggressive disk 

fds light tandem disk – less aggressive disk 

fdt heavy tandem disk – moderately aggressive disk 

fnts strip till – no till where a strip of soil is disturbed by a chisel point in the fall prior to 
planting, and by coulters mounted on the planter or on a tool bar in front the 
planter 

fp fall moldboard plow 

fs fall seeded 

gr harvested for grain 

inj manure injected 

int or intsd inter-seeded by air into the standing crop  

manb manure bedded 

maninjhd  manure liquid injected with high disturbance injector  

maninjld    manure liquid injected with low disturbance injector  

manl manure liquid 

manp manure poultry 

manss manure slurry 

nr narrow row crops generally drilled at 7 inch spacing 

note:  corn is wide row (30 inch spacing), unless specified as nr, which is 18 inches; 
small grains are always narrow row (and not specified) 

nt no till 
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Abbreviations – Arranged Alphabetically cont. 
nts strip till – no till where a strip of soil is disturbed by a chisel point in the spring prior to 

planting, and by coulters mounted on the planter or on a tool bar in front the planter 
 

ntz zone till – no till where a strip of soil is disturbed by fluted coulters mounted on the 
planter or on a tool bar in front of the planter 

oatcc oat cover crop 

p moldboard plow 

pc plastic culture for vegetables 

rc row cultivator used during the growing season, primarily for weed control 

rt ridge till – row crops are planted on ridges formed during the prior growing season; 
not common in PA 

sc1 field cultivator equipped with sweeps – one pass 
sc2 field cultivator equipped with sweeps – two 
passes 

scst chisel with straight shanks – moderately aggressive chisel 
scswp chisel with sweeps – less aggressive chisel 

sctw chisel with twisted shanks – most aggressive chisel 
sdos offset disk – most aggressive disk 

sds light tandem disk – less aggressive disk 

sdt heavy tandem disk – moderately aggressive disk 
si or sil harvested as silage 

sp spring moldboard plow 

ss spring seeded 

wgcc winter grain cover crop 

wr wide row crops generally planted with a planter at 30 inch spacing 

note:  corn is wide row (30 inch spacing), unless specified as nr, which is 18 inches; 
small grains are always narrow row (and not specified) 
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Abbreviations – Arranged by Category 

 

Crops and cropping 
 

dc double cropping such as corn or soybeans following small grain, or corn following hay 
harvest; mostly in south-central and south-eastern PA 

dcnr same as above but planted with a drill 
gr harvested for grain 
pc plastic culture for vegetables 
si or sil harvested as silage 
oatcc oat cover crop 
wgcc winter grain cover crop 

 

Manure and manure management 
 

inj manure injected 
manb manure bedded 
maninjhd  manure liquid injected with high disturbance injector  
maninjld    manure liquid injected with low disturbance injector 
manl manure liquid 
manp manure poultry 
manss manure slurry 

 

Planting and related operations 
 

bd broadcast method of seeding, usually cover crop  
int or intsd inter-seeded by air into the standing crop 
fs fall seeded 
nr narrow row crops generally drilled at 7 inch spacing 

note:  corn is wide row (30 inch spacing), unless specified as nr, which is 18 inches; small 
grains are always narrow row (and not specified) 

nt no till 
fnts strip till – no till where a strip of soil is disturbed by a chisel point in the fall prior to 

planting, and by coulters mounted on the planter or on a tool bar in front the planter 
nts strip till – no till where a strip of soil is disturbed by a chisel point in the spring prior to 

planting, and by coulters mounted on the planter or on a tool bar in front the planter 
ntz zone till – no till where a strip of soil is disturbed by fluted coulters mounted on the 

planter or on a tool bar in front of the planter 
rc row cultivator used during the growing season, primarily for weed control 
rt ridge till – row crops are planted on ridges formed during the prior growing season; not 

common in PA 
ss spring seeded 
wr wide row crops generally planted with a planter at 30 inch spacing 

note:  corn is wide row (30 inch spacing), unless specified as nr, which is 18 inches; small 
grains are always narrow row (and not specified) 
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U 
Tillage  
 
Below the tillage types, are the codes and abbreviations in bold, i.e., fp, that are part of the crop 
template name.  Primary tillage types are listed.  Under the secondary tillage, are the operations used in 
preparation of the crop templates.  A listing of the same piece of equipment more than one time 
indicates more than one pass over the field with that implement. 
 

 
PRIMARY TILLAGE     SECONDARY TILLAGE 
 
Moldboard Plow  fp (fall)  sp (spring)  Disk, tandem heavy primary 
       Disk, tandem light finishing 
       Harrow, coiled tine 
 
 
Chisel, twisted  fctw (fall)  sctw (spring)   Disk, tandem heavy primary 
 (high tillage/low residue)   Disk, tandem light finishing 
 
 
Chisel, straight fcst (fall)  scst (spring)   Disk, tandem heavy primary 
 (moderate tillage/moderate residue)  Disk, tandem light finishing 
 
 
Chisel, sweeps fcswp (fall)  scswp (spring)  Cultivator, field 6-12” sweeps  

(low tillage/high residue) 
 
  
Disk, heavy/offset fdos (fall)  sdos (spring)  Disk, tandem heavy primary 
 (high tillage/low residue)   Disk, tandem light finishing 
 
 
Disk, tandem heavy   fdt (fall)  sdt (spring)  Disk, tandem heavy primary 
 (moderate tillage/moderate residue)  Disk, tandem light finishing 
 
 
Disk, tandem  fds (fall) sds (spring)  Disk, tandem secondary 
 (low tillage/high residue) 
 
Cultivator, field; 6-12” sweeps*       none     
ffc1 (fall)  sfc1 (spring)  
 
Cultivator, field; 6-12” sweeps*        Cultivator, field; 6-12” sweeps 
ffc2 (fall)  sfc2 (spring) 
 

 *1 & 2 in symbol denotes the number of implement passes 
 
Seedbed Conditioner – is Vertical-Till or Turbo-Till High residue crop  
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Manure Operations – Abbreviations and Descriptions 
 

The following is a list of manure operation abbreviations and their descriptions, as used in the 
preparation of crop templates for Crop Management Zones 4.1, 62 (intermediate planting dates), and 
65. The manure types are the codes that are part of the crop template name for all templates where 
manure is used. The spreaders are specifically selected because of the properties included in the 
databases. The manure types were selected to represent the most common types of manure used in 
each of the multi- state CMZs.  The decomposition rates are included in the database. The table 
shows the average dry matter that is applied for each method. The dry matter rates are based on 
average N- and P-based nutrient management plan rates for typical yields of grain and silage corn. 

 
 
 
 
 

MANURE TYPE MANURE SPREADER LBS. DRY MATTER 

LIQUID  1000 

manl Liquid spreader (50% infiltration) 6000 gal @ 2% dry matter 

maninjhd Injector – high disturbance 30” (50%) 6000 gal @ 2% dry matter 

maninjld Injector – low disturbance 15” (30%) 6000 gal @ 2% dry matter 

 

MANURE, MODERATE BEDDING 3000 

manb Manure spreader, solid & semi-solid 6 tons @ 25% solids 

 

MANURE, POULTRY  3000 

manp Manure spreader, solid & semi-solid 6 tons @ 50% solids 

 

MANURE, SEMI-SOLID & SLURRY 3000 

manss Manure spreader, slurry 

10 tons @ 15% solids or 
5000 gal @ 7% solids 
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Example Cropping System Worksheet 
 

Producer: John Smith 

 

 

Tract No: 943 Fields: 1, 2, 3, & 4 
  

 
 

Crop Rotation 
 

1st Year Corn/Grain 4th Year Winter Wheat 
2nd Year Fallow 5th Year Alfalfa (7 years) 
3rd Year Bean 6th Year  

 
 

Tillage Operations and Yield Yield (5-year Average Normal Precipitation) 
 

Crop 1:  Corn - 130 bu yield Crop 4:  Barley - 70 bu yield 
Date: 
4/1 

 Operations: 
Moldboard Plow 

Date: 
3/15 

 Operations: 
Disk Offset 

4/15  Tandem Disk 4/1  Cultipacker, roller 
4/20  Chisel w/sweeps 4/5  Double-disk Drill - 10" row 
5/1  Double-disk Planter - 30" rows 7/1  Harvest 
6/15  Row Cultivate 9/1  Graze Wheat Stubble 
7/1  Row Cultivate    
10/1  Harvest for Grain    

 
    

 

Crop 2:  Fallow  Crop 5:  Alfalfa - 4 ton yield 
Date: 
5/15 

 Operations: 
Offset Disk 

 Date: 
4/1 

 Operations: 
Moldboard Plow 

6/15  Chisel Plow Sweeps  4/15  Offset Disk 
7/20  Chisel Plow Sweeps  4/20  Tandem Disk 
9/1  Chisel Plow  5/15  Double-disk Drill - 10" rows 

    7/1  Harvest 
    9/1  Harvest 
    10/1  Graze Alfalfa Aftermath 

 
    

 

Crop 3:  Beans - 20 cwt yield  Crop 6: 
Date: 
3/1 

 Operations: 
Grazed Corn Stubble 

 Date:  Operations: 

5/1  Moldboard Plow     
5/15  Tandem Disk     
5/20  Chisel with Sweeps     
6/1  Double-disk Planter - 30" rows     
7/1  Row Cultivate     
9/10  Harvest     
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Crop 1: 
Date: Operations: 

Crop 4: 
Date: Operations: 

Cropping System Worksheet 
 

Producer: 
 

Tract No: Fields: 
  

 
 

Crop Rotation 
 

1st Year 4th Year 
  

2nd Year 5th Year 
  

3rd Year 6th Year 
  

 
 

Tillage Operations and Yield Yield (5-year Average Normal Precipitation) 
 
 

 

 
 
 

   

 
   

 
   

 
   

 
   

 
   

 
   

 
   

 

Crop 2:   Crop 5:  

Date:  Operations: Date:  Operations: 

 
   

 
   

 
   

 
   

 
   

 
   

 
   

 

Crop 3:  Crop 6:  

Date: Operations: Date: Operations: 
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Equipment Worksheet 
 
 

 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Check the boxes below for Field Equipment used in your farming operation:   

Planter 
 Double-disk opener with or 

without fluted coulter 

 Double-disk opener, 18" rows 

 Furrow opener in 4", 6", or 8" 
deep furrows 

 In-row subsoiler 

 Narrow slot w/smooth or rippled 
coulter 

 Runner opener 

 Ridge till attachments 

 Strip till attachments 

 

Fertilizer  Applicators 

 Coulter, high pressure injector, 
12" spacing 

 Anhydrous knife, 12" spacing 

 Shank low disturbance, 12" 
spacing 

 Deep placement heavy shank 

 Surface broadcast spreader 

 Anhydrous knife, 30" spacing 

 Strip till, 30" spacing 

 

Tillage/Cultivation  Equipment 
 Field cultivator, field, 6-12" 

shovels 

 Chisel, sweep shovel 

 Field cultivator, field, 6-12" 
sweeps 

 Chisel, twisted shovel 

 Field cultivator, field w/ spike 
points 

 Disk, offset, heavy 

 Disk, tandem, heavy primary 

 Disk, tandem, light finishing 

 Mulch finisher (one pass) 

 Residue, row cleaner 

 Rodweeder 

 Rotary hoe 

 Row cultivation 

 Seedbed Conditioner 

 Subsoiler 

 Subsoiler ripper, 24-40" deep 

 Harrow, coiled tine 

 Harrow, heavy or rotary 

 Harrow, spike tooth or tine on 
beds 

 Power mulcher bed conditioner 

 Plow, disk 

 Plow, moldboard 

 

Manure Application 

 Liquid high disturb, 30" spacing 

 Liquid low disturb, 30" spacing 

 Liquid low disturb, 15" spacing 

 Dry manure spreader 

 

Drill or Air Seeder 

 Tee slot openers, 7-10" rows 

 Hoe/chisel openers, 12-15" rows 

 Hoe/chisel openers, 6-12" rows 

 Sweep or band opener 

 Offset double-disk openers 

 Double-disk openers 

 Single-disk openers, 7-10" rows 

 Double-disk opener w/fluted 
coulter 

 Double-disk opener w/fert. 
openers 

 Single-disk openers + fert. 
openers, 7-10" rows/spacing 

 Deep or semi-deep furrow, 12- 
18" spacing 

 Heavy, direct-seed, double-disk 
opener with or w/o row cleaners 

 Double-disk, 7-8" packer 

 

Combine 

 Rotary with residue spreader 

 Rotary without residue spreader 

 Non-rotary with residue spreader 

 Non-rotary without residue 
spreader 

 

Stalk Shredding Equipment 

 Shredder, flail or rotary 

 Shredder, rotary mower 

 Stalk chopper, rotary 

 Other shredding equipment 

 
Other Equipment 

  
  
  
  
 


	Welcome to RUSLE2
	About RUSLE2
	A = R K L S C P
	RUSLE2 PROGRAM SETUP
	Create a RUSLE2 Shortcut Icon for Your Desktop
	Downloading RUSLE2 Databases
	RUSEL2 Folder/Data Location
	Download Base Database and Database Updates - NRCS USERS CAN SKIP THIS SECTION
	http://fargo.nserl.purdue.edu/RUSLE2_ftp/NRCS_Base_Database/Latest%20Base%20Database%20and%20Updates/
	2) Click on “NRCS Moses Updates 030104 to 01292015.zip”
	Download Crop Management Zone (CMZ) Database - NRCS USERS CAN SKIP THIS SECTION
	Download Soils Data - NRCS USERS CAN SKIP THIS SECTION
	Download Climate Data - NRCS USERS CAN SKIP THIS SECTION
	Importing Files
	NRCS USERS CAN SKIP THIS SECTION
	Extracting Files
	RUSLE2 INTRODUCTION
	Program Feature Icons
	Creating a RUSLE2 Rotation
	Creating a Plan in RUSLE2 – applying the crop rotation and calculating soil loss
	Abbreviations – Arranged Alphabetically

	Example Cropping System Worksheet
	Cropping System Worksheet
	Equipment Worksheet


